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Preface 

This document assumes that the reader knows the Windows environment and understands basic 

school administration terminology.  

Related References 

Refer to the CampusVue Help System for more information about topics discussed in this 

document. 

Document Conventions 

The following conventions are used to help guide the reader in finding information quickly.  

 

Convention Use 

BOLD Names of files, keys, forms, paths, and program 
components  

> Symbol used in paths to signify a shift to the next level of 

options 

Note: Important information 

 

Definition of Terms 

 

The word “student” is used to refer to any individual with a record in the CampusVue database, regardless 

of that person’s current or former status with the institution. 



 

CampusVue User Guide:  Basic Navigation 4 

Table of Contents 

Basic Navigation 1 

User Guide 1 

Campus Management Corporation.........................................................................2 

Web Site .................................................................................................................2 

E-mail.....................................................................................................................2 

Phone......................................................................................................................2 

Address...................................................................................................................2 

Trademark Attributions ..........................................................................................2 

Copyright................................................................................................................2 

Preface 3 

Related References.................................................................................................3 

Document Conventions ..........................................................................................3 

Definition of Terms................................................................................................3 

Table of Contents 4 

Introduction to CampusVue 6 

The CampusVue Desktop 7 

The CampusVue Work Area ..................................................................................8 

Title Bar .................................................................................................................9 

Menu Bar................................................................................................................9 

File Menu .................................................................................................................. 10 

Find Menu ................................................................................................................. 10 

View Menu................................................................................................................ 11 

Lists Menu................................................................................................................. 12 

Daily Menu................................................................................................................ 12 

Reports Menu ............................................................................................................ 13 

Window Menu........................................................................................................... 13 

Tools Menu ............................................................................................................... 14 

Setup Menu ............................................................................................................... 14 

Help Menu................................................................................................................. 15 

Shortcut Bar .........................................................................................................15 

Student Bar...........................................................................................................18 

Status Bar .............................................................................................................19 

User Toolbar.........................................................................................................19 



Table of Contents   

  

Logging In and Navigating CampusVue User Guide:  Basic Navigation 5 

Searching for Student Records 22 

The Student Search Form.....................................................................................22 

Basic Search .........................................................................................................23 

Advanced Search..................................................................................................24 

Search Tips...........................................................................................................26 

The Student Master Form 29 

Layout ..................................................................................................................29 

Student Master Form Border Colors ....................................................................31 

Icons .....................................................................................................................32 

Buttons .................................................................................................................33 

Editing the Student Master Form .........................................................................33 

The CampusVue Help System 35 

Contents Tab ........................................................................................................36 

Index Tab .............................................................................................................37 

Search Tab............................................................................................................38 

Favorites Tab........................................................................................................39 

Help System Toolbar............................................................................................39 

Shortcut Menus (Right Mouse Button) ................................................................40 

Related Topics Button..........................................................................................41 

Context-Sensitive Help ........................................................................................41 

Appendix A - Keyboard Shortcuts 42 

Index 43 



 

CampusVue User Guide:  Basic Navigation 6 

Introduction to CampusVue 

The CampusVue system for the administration of educational institutions has many features designed 

to help you get your job done quickly and efficiently.   

 

CampusVue has the familiar look and feel of a Windows-based application.   

CampusVue can be customized to operate according to your school’s business practices and 

procedures.   

CampusVue is organized like your school:  it’s composed of modules which correspond to the 

functional departments on your campus. 

CampusVue has a comprehensive online Help system and a support desk available via Internet, e-mail, 

and telephone. 

This user guide for navigating the CampusVue application will acquaint you with the basic layout 

of the CampusVue screen, the steps for finding student records and other information, and the 

many ways in which you can find answers to your questions about how to keep CampusVue 

working its best for you. 
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The CampusVue Desktop 

This section prepares you to: 

� identify the parts of the CampusVue desktop 

� explain why different users may see different desktops 

� open menus and submenus using the Menu Bar 

� use keyboard shortcuts 

� manage open and active windows 

 

CampusVue opens in a window called the CampusVue Desktop.  

 

 

The look of your personal CampusVue desktop is determined by your security permissions.  

“Permissions” refers to that group of menus, icons, folders, and processes to which you have 

access in the CampusVue application.  These permissions are based on your job description and 

Student Bar 

Menu Bar 

Recent Students Box 
Title Bar 

Status Bar 

CampusVue Work Area 

Shortcut (Tool) Bar 
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are associated with your user ID, so it is important that you keep your login information 

confidential.  If you discover that your permissions prevent you from performing your job duties 

in the CampusVue system, notify your supervisor or system administrator. 

Your CampusVue desktop is where you will perform your daily activities and functions.  On the 

desktop, you will find tools for use in navigating the CampusVue application.  They include the 

Title Bar, the Menu Bar, the Shortcut Bar, the Student Bar, the Recent Students Box, the 

Status Bar, and the CampusVue Work Area.  Each item is described further in the following 

sections. 

The CampusVue Work Area 

The CampusVue Work Area is the large blue area of the desktop where folders and forms open, 

each in its own separate window.  You can have many windows open in this work area 

simultaneously.  As each new window opens, it will appear “in front” and may hide all or part of 

other open windows.  At any time, you can click Window on the CampusVue Menu bar to see a 

list of your currently-open windows.  A checkmark indicates the active window, and you can 

switch to another window by selecting it on the list.  Alternatively, you can simply click 

anywhere in a window to make it active and bring it to the front.  As in other Windows 

applications, you can also move windows around by “dragging” them by their title bar. 

 

 

Note:  There is a distinction between an open window and an active window. Several 

windows can be open at the same time but only the active window – the one in front 

– can be edited or updated. 

 

Pop-up Menu:  Right-click in the blue work area to see a menu of useful tools and shortcuts. 
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Title Bar 

The Title Bar reads CampusVue - your school’s corporate name. 

 

If you have permissions in more than one database (for example, if you have access to work in 

the data for more than one campus), the title bar’s information may change as you switch between 

databases. 

Menu Bar 

The CampusVue Menu bar is the gateway to the program. Remember that the Menu bar reflects 

the permissions of the user who is logged in, so your personal Menu bar may vary from the full 

Menu bar pictured here. 

 

 
 

Clicking on a Menu bar item displays a submenu.  In the example below, clicking the Daily menu 

displays a list of departmental modules; resting the mouse pointer on Admissions brings up the 

Admissions Daily menu: 

 

 
 

Again, your permissions will determine which menus appear on your desktop and which submenu 

options are available to you.  For example, some options on your submenus may be “grayed-out” 

or “dimmed.”  This indicates that the option is either inactive or unavailable to you.   

 

Note:  If you access your department’s Daily menu frequently, you can click <Detach> to 

keep the Daily menu constantly open in your work area. 
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File Menu 

The File menu includes options for adding a new lead, closing the active window, refreshing the 

active form, deleting a record, printing a picture of your screen, setting up printer options, quick 

return to recently-accessed records, logging off, closing all open forms at once, and exiting from 

the CampusVue application. 

 

 

Some menu options have keyboard shortcuts associated with them. For example, the F5 key 

“refreshes,” or updates, an active form.  See Appendix A for a list of keyboard shortcuts. 

Find Menu 

The Find menu leads you to records for an individual student or a group of students via the 

Student Search form. It can also move you to the next name in your Recent Students list. 
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View Menu 

The View menu lets you view and edit individual student information in the CampusVue system.  

Options are organized by department and reflect the tabs and folders on the Student Bar.  For 

example, selecting View > Admissions > Tests (below left) is the same as going to the Student 

bar, clicking on the Admissions tab, and opening the Tests folder (below right). 

                                   

 

The Student Groups and Employer Groups options will open the forms for managing the 

selected groups. 

The Session Defaults option offers access to your session defaults (session parameters) for 

Campus, Term, FA Year, and Module settings.  Defaults remain set until you change them. 

 

At the bottom of the View menu you can elect whether to see the Student Bar, Toolbar, and 

Status Bar on your CampusVue Desktop.  (Two additional options, Customize User Toolbar and 

User Toolbar, may appear if your system administrator has enabled user toolbars.) 
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Lists Menu 

The Lists menu is also organized by campus departments.  It is used to maintain the many lists of 

choices that appear in the drop-down boxes throughout the system.  The departmental lists are 

centrally controlled in this way in order to maintain data and reporting integrity.    

Select a department option to open the Setup -- Lists form for that department.   

   

Each list is presented on a separate tab on the form.  The screenshot below shows the Student 

Services lists.  The brackets on the title bar will indicate the name of the tab (list) that has been 

selected. 

 

Daily Menu 

The Daily menu for each department leads to a list of that department’s batch processes.  Move 

the mouse pointer over a department name to display that department’s Daily menu, and then 

click on your selection. 
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Reports Menu 

The Reports menu is organized by department.  Move the mouse pointer over a department name 

to display that department’s menu and make your selection.  An asterisk (*) denotes a custom 

report designed expressly by, or for, your institution. 

 

Click Open Report Selector to see a list of all departmental reports you have access to. 

See individual department user guides or CampusVue Help for information on running reports. 

Window Menu 

The Window menu lists the currently open windows in the CampusVue work area. Since 

CampusVue is capable of having many windows (forms) open at the same time, this menu 

changes as you open and close various forms. A check mark indicates the active window.  The 

Window menu includes options for arranging windows in the work area in tiled format or in 

cascaded format. 
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Tools Menu 

The Tools menu is organized by department and offers access to specialized processes.  For 

example, in the Contact Manager tools menu there is a tool that checks the phone numbers in 

your database against the National Do Not Call List. 

 

Setup Menu 

Your system administrator uses the Setup menu to configure basic system operation and 

determine many of the system defaults.  The Setup menu controls system parameters such as 

campus and staff member identification, settings for the various modules, security, access to the 

data dictionary, and other functions.  Access to the Setup menu is heavily restricted. 
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Help Menu 

Help > Contents is the path to access the CampusVue Help system.  About opens a window 

containing information about the version and build of CampusVue you are using. 

 

 

See the section on CampusVue Help for more information. 

Shortcut Bar 

The Shortcut Bar contains a variety of command buttons that are marked with unique icons.   

 

 

 

These buttons are found to the left and right of the Recent Students box.  Clicking a button starts 

a task or opens a form or folder as described in the table below. 

 

Remember that your security permissions may determine whether a particular button appears on 

your Shortcut bar. 

Icons 
 

The tables on the following pages list the Shortcut bar buttons and their functions. 
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Buttons to the left of the “Recent Students” box: 

 

 

Quick Lead icon The Quick Lead icon is used most often by 
Admissions personnel who enter new lead 
information into CampusVue. 

 

New Lead Icon The New Lead icon opens a blank student 
record form.  The down arrow beside it opens 
a blank employer form. 

 

Print Icon The Print icon is a “print screen” command. 

 

 

Find Icon The Find icon opens a search form.  The 
binoculars open a Student Search; the down 
arrow offers options for Employer or Staff 
search. 

 

Student Groups 
Icon 

 

The Student Groups icon opens a list of 
existing student groups and allows you to add, 
search, or work with groups. 

 

Contact Manager 
Icon 

 

The Contact Manager icon opens the screen 
that displays your activities, such as phone 
calls and appointments. 

 

 
 

Employer Search 
icon 

The Employer Search icon opens the 
Employer Search form.  It is only active when 
you are working in the employer database. 

 
 

Close All Forms  
Icon 

The Close All Forms icon closes all open and 
active forms on the desktop. 

 

Exit Icon 

 

The Exit icon is the shortcut to closing the 
CampusVue application. 

 

Toggle Icon The Toggle icon switches between recent 
students and recent employers.  You can use 
it to open the employer database. 
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Buttons to the right of the “Recent Students” box lead to information about the 

student whose name appears in the box (the “current” student): 

 

        
 

       

 
Green light 
 
 
Red light 

Student is not on hold 

Student is on hold.  Hover the mouse pointer 
over a red light to see what kind(s) of hold the 
student is on. 

        

 
FERPA Information 
Icon  

The FERPA Information icon allows user to 
view the FERPA (Federal Educational Rights 
and Privacy Act) information for the current 
student (this icon only appears when there is 
information to view). 

       

 
Student Contact 
History  

The Student Contact History icon opens the 
student’s Activities folder, which displays all 
current and historical activities that have been 
entered in Contact Manager for that student. 

       

 
Student Groups 
Icon 

 

The Student Groups icon opens the student’s 
Student Groups folder and displays any groups 
of which the student is a member.  Here you 
can add the student to a group or remove the 
student from a group. 

       

 
Documents Icon 

 

The Documents Icon opens the student’s 
Documents folder, which lists all documents 
being tracked for the student. 

         

 
Addresses Icon 

 

The Addresses icon opens the student’s 
Addresses folder, showing all addresses and 
other contact information for the student. 

      

 
Reference 
Addresses 

 

The Reference Addresses icon does not 
necessarily relate to the current student.  
Select this tool to search for one or more 
students by the contents of their alternative 
addresses (often used for loan references). 

      

 
Employer Groups 
icon 

The Employer Groups icon opens the list of 
groups to which the employer belongs.  Here 
you can add the employer to a group or 
remove the employer from a group.  This icon 
is active only when you are working in the 
employer database. 
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The Recent Students Box 
 

In the center of the Shortcut bar is the Recent Students box. 

 

  

The student whose name appears in the Recent Students box is the “current” student – the student 

whose records can be found on the Student bar. 

Click the down-arrow to the right of the Recent Students box to drop a list of the most recently 

accessed student records: 

  

Click on a name in the list to make that student the “current student.”  This action opens the 

student’s Student Master form and puts that student’s information in the Student bar. 

 

Student Bar 

The Student Bar is located on the left side of the CampusVue Desktop.  The Student Bar matches 

the View Menu, giving you easy access to information regarding the “current” student (the 

student whose name appears in the Recent Students box).  

   

Student Bar 
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The Student Bar functions much like a file cabinet, where each campus department occupies its 

own file drawer. Click on a departmental tab or “file drawer” to open it, and then click on a file 

folder to open that folder in your work area.  You need not close one folder before opening 

another – it’s possible to have many folders open at once, even if they belong to different 

students. 

Note:  The Student Bar belongs to only one student at a time:  the student whose name is in 

the Recent Students box (also known as the “current” student).  To access another 

student’s records, select another student from the Recent Students list (by clicking 

the down arrow), OR click the Binoculars to search for another student and open 

that student’s record (see “Searching for a Student Record”).  Both methods will 

change the name in the Recent Students box, and the contents of the Student Bar 

will now belong to that student. 

Status Bar 

The Status Bar is located at the bottom of the screen and displays basic information about current 

system operations.   

 

The individual cells are described in the table below: 

 

 

 
Mode Indicator The mode of the active window:  Add, Edit, or 

Display. 

 
User ID The user ID of the user who is currently logged 

on. 

 
Campus The campus in which the current user is working.  

Double-click to open the Session Defaults box. 

 
Form The name of the form currently open (or most 

recently opened). 

 
System date The date which will be stamped on all database 

transactions. 

User Toolbar 

The system administrator may allow you to create a User Toolbar that displays custom-selected 

data fields for your current student.  In this manner you can quickly view specific information 

without having to open multiple student folders.  

To create a customized user toolbar: 

1 Select View > Customize User Toolbar to open the Customize User Toolbar form: 
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2 Pick your custom items from the lists.  At the top left, you can select the forms or folders to 

which you would like a shortcut button. 

3 Here, from the list on the right we select View/sa/Payment Schedule. 

 

4 Click the  button to move your selection to the “Selected” list on the right.  A window 

opens for you to choose an icon for your custom button to open the “Payment Schedule” 

form.   
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5 Select an icon and click Select to close the window and create your new custom entry. 

 

6 At the bottom of the form, you can select items of the current student’s information that you 

would like to be displayed automatically in your work area. 

7 Here we have selected AR Balance and Graduation Date. 

 

8 When you have made your selections, click Apply and Close. 

9 Return to your view menu and select User Toolbar. 

 

10 View your custom toolbar in the top left corner of your CampusVue blue work area.  Here we 

have a shortcut to the student’s payment schedule and two data fields, A/R Balance and 

Graduation Date: 
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Searching for Student Records 

This section prepares you to: 

� Search for students by name or social security number 

� Search for groups of students who share common attributes  

 

The Student Search form quickly and effectively locates student records in CampusVue.  In this 

topic, you will learn how to do a “basic” search for a student based on the student’s name, social 

security number, or other ID number.  You’ll also learn how to do “advanced” searches, which 

use pre-defined filters to find groups of students who share common characteristics, such as the 

same school status. 

The Student Search Form 

There are five ways to open the Student Search form: 

� Click the Search    icon with the binoculars. 

� Click Find on the menu bar and select Student. 

� Double-click in the blue CampusVue work area with the left mouse button. 

� Right-click in the blue CampusVue work area and select Find Student from the menu. 

� Use the keyboard shortcut Ctrl+F. 
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The Student Search form has three tabs:  Search, Advanced, and Groups.  The Search tab 

allows you to perform a basic search, most commonly by last name and/or first name or SSN.  

The Advanced tab allows you to perform an “Advanced” search, which is a filtering process that 

limits the records returned to only those that match your selection criteria.  The Groups tab is 

used to form a group from the search results. 

Basic Search 

To search for an individual student: 

1 Enter the student’s last name and/or first name and/or social security number or other 

identifying number on the Search tab (you do not have to capitalize names). 

2 Click the Search button or hit the Enter key on your keyboard. 

 

 

In this example, eight records matched the search criteria of “barn.”  They appear in table 

format on the bottom half of the form, where each line represents one student record. These 

are the Search Results, and the total number of records retrieved appears in the lower left 

corner of the form.   

3 Double-click a name to open the corresponding Student Master form.  Notice that opening a 

student record inserts that student’s name in the Recent Students box and puts that student’s 

information in the Student Bar. 

 

NOTE:  You may notice a name appearing more than once in your search results.  The same 

name may belong to more than one person, or a student may have more than one 

record in your database (for example, a currently-attending student may have an old 

lead record from several years ago).  If a student has only one record but has 

multiple enrollments that satisfy your search criteria, each of those enrollments will 

be represented in the search results. 



Searching for Student Records   

  

Logging In and Navigating CampusVue User Guide:  Basic Navigation 24 

Advanced Search 

An advanced search permits you to search for groups of students who share one or more common 

attributes, such as the same school status or the same Admissions rep. 

To perform an advanced search: 

1 Click the Advanced tab in the search form. 

 

2 In the Field column, click the down arrow to select the first attribute to be used in the 

filtering process. 

3 In the Value column, click the down arrow to select a corresponding value.  (Hint:  for the 

first column, picture a field in the student’s record that you want to search on; for the second 

column, what do you want that field to say?)  
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4 You can add additional lines to the grid to narrow your search further. 

5 Click the Search button (or the Enter key on your keyboard) to trigger the search.  In the 

example below, 21 students have a school status of “Being Processed.” 

 

6 Use additional rows of the Field/Value table to add layers to your search and narrow the 

results further.  For example, the addition of a second row to our example shows that 15 of 

the original 21 students were enrolled by Able Baker. 

 

     

NOTE:  Some criteria, such as “City” in the example below, have no down arrow in the Value 

column, indicating that you can type (in this case a city name) directly into the field. 
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Search Tips 

The following tips will not only help you to perform faster, more accurate searches, but they will 

also help you to get the most out of the Search form. 

TIP:  Reset the Search Form 

The Search form retains the results of the last search in your current login session.  To perform 

subsequent searches, you may need to clear all previous search criteria.  To begin a new search, 

click the Reset button on the right. 

 

A Reset may be especially important if your last search used both tabs, because both the Search 

and Advanced tabs contribute to the search results.  If a search yields the “No Students Were 
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Found” message, it may be necessary to clear search criteria on one of the tabs, especially if you 

are switching from a basic to an advanced search or vice versa. 

 

TIP:  Abbreviate names 

Due to occasional misspellings of a student’s name in the system, it may be prudent for you to 

search by entering only the first few letters in a student’s name instead of the full name.  For 

example, use Chr instead of the full name of Christina, which might have been entered as 

“Christine” by mistake. 

 

TIP:  Use “wildcard” characters 

The underscore character ( _ ) can replace one character in the search criteria field.  In the 

example below, we entered "a_c" in the last name field, and the search retrieved students named 

Adcock, Arche, Archer, etc.  
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The percent character (%) can be used to replace a string of characters. Example: If you entered 

"%Donald" in the last name field, you would get students named MacDonald, McDonald, 

Mcdonald, etc.. 
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The Student Master Form 

This section prepares you to: 

� View and edit student demographic information 

� Save previous address information for a student 

� Determine a student’s status 

� Add comments to a student’s record 

 

The bulk of information stored within CampusVue is organized around students, and the heart of 

a student’s record is the Student Master form.  This topic focuses on the data contained on the 

Student Master form:  how it gets there, how to edit it, and how to use the icons on it. 

You can open the Student Master form in any of three ways: 

1 Find the student via the Student Search form and double-click on the student’s name. 

2 Choose the student from the drop-down list in the Recent Students box. 

3 With the student’s name in the Recent Students box, click the Student folder under any 

departmental tab on the Student Bar. 

Layout 

The information on the Student Master form is presented in two columns.   

The left-hand column contains demographic information about the student. 
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The right-hand column contains fields which describe the student’s relationship with the school. 

 

 

The Student Master form may be sparsely populated at first, especially if it was created by saving 

a Quick Lead form, which is often used by personnel who take inquiry calls and need to enter 

student information quickly before transferring the caller to an Admissions representative.  Since 

the Quick Lead form has only a handful of fields, a new student record will have many empty 

fields.  As more school personnel work with the student, they edit the form with the additional 

information they gather. 

 

Notice that some of the fields appear colored or highlighted:   

 

 

These are required fields.  This convention is used throughout the CampusVue system to 

indicate a field that must be completed before the form you are editing can be saved.   Your 

institution can customize the color of required fields. 
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Student Master Form Border Colors 

Each Student Master form has a colored border that corresponds to the student’s Status 

Category.  (Think of a status category as a stage in the life cycle of a student at your school.) 

There are seven status categories defined by the CampusVue system:  Lead, Applicant 

Processing, Enrolled, Never Started, Active, Temporary Out, and Permanent Out.  The 

CampusVue default border colors are presented below.  Your institution can customize the color 

used for each status category at Setup > Status Codes > Colors. 

 

 

A status category may contain one or more School Statuses.   

For example, the “Active” status category, which represents the current student population, may 

contain such school statuses as Active, Probation, Externship, and/or Pending Graduate.  The 

names of these School Statuses are determined by your institution’s business practices. 

The School Status field is located in the upper right corner of the Student Master form.  The 

combination of status category and school status indicates the student’s current standing with the 

school. 
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Icons 

There are three icons in the lower right-hand corner of the Student Master form.  Their functions 

are described in the table at the bottom of the page. 

 

 
 

 

 

 

 

 

Comment icon The Comment icon allows you to add a comment to the 
student’s record.  When a comment is entered here, the 
icon will change from a white comment box to a yellow 
lined note.   Clicking on it will allow you to add, edit, or 
delete comments.  If comments are entirely deleted, the 
icon will return to a white comment box.  Comments 
entered via this comments box are not tracked for 
reporting purposes and an audit trail is not kept as to 
who entered, edited, or removed the comments. 

 

Activities icon 

 

The Activities Icon allows you to add a Contact 
Manager activity for the student.  Activities entered via 
this icon are included in the student’s Contact History 
and included in reports. 

 
Print Labels icon The Print Labels icon allows you to print an individual 

mailing label for this student. 
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Buttons 

Along the lower border of the Student Master form are a series of buttons or cells of information: 

 

 
Opens a digital photo of the student (if one has 

been saved) 

 

 

 

 

Opens a form from which you can send an e-mail 

message to the student, provided the student has a 

viable e-mail address in the Student Master form 

and an e-mail client is configured 

Opens a form from which you can send an SMS 

text message to the student, provided the student 

subscribes to the SMS service and a viable mobile 

number is provided in the Student Master form. 

 

 

Indicates that this student has more than one 

enrollment in the system.  Many CampusVue forms 

display enrollment-specific information which 

changes when different enrollments are selected.  

(This box is not present if the student has only one 

enrollment) 

 
Puts the form in Edit mode for adding or changing 

information 

 
Saves changes (activated in Edit mode) 

 
Cancels changes (activated in Edit mode) 

 
Closes the form 

Editing the Student Master Form  

The Student Master form may contain sparse information at first.  As the student progresses 

through the Admissions and Applicant processes, more information is collected on the student 

and added to the student’s record by way of the Edit process. 

To Edit the Student Master form: 

1 Click the Edit button to activate those fields in which you have permission to make changes. 

2 Add or edit information as required. 



The Student Master Form   

  

Logging In and Navigating CampusVue User Guide:  Basic Navigation 34 

3 Click Save to save your changes. 

4 If you make changes to certain contact information fields, you may be prompted to save the 

old address information to the student’s Addresses folder via the Save Old Address form 

(former contact information can be useful).   

 

  

 

If you wish to save the old information, click the down-arrow on the Address Type field to 

select the type of address you are saving (usually “Previous”), and click Save.   If you do not 

wish to save the old information, click Close and then click No on the “second chance” 

message that appears. 
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The CampusVue Help System 

This section prepares you to: 

� browse Help information by subject matter 

� use the Help index 

� search the Help system by keyword 

� save Help topics to the Favorites tab 

� open context-sensitive Help 

� navigate the Help toolbar  

 

The Help System in CampusVue is an invaluable resource for new and experienced users alike.  

Extensively illustrated with screen shots from the application, Help is always a click away with 

information on topics both basic and advanced. 

On the Menu Bar, click Help > Contents to open the CampusVue Help Library in a new browser 

window.  

 

 
 

The left pane contains four tabs:  Contents, Index, Search, and Favorites.  The right pane displays 

the Help system home page. 
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Contents Tab 

The Contents tab is organized much like the table of contents in a book.  Click the plus (+) 

symbol beside any book icon to expand the list associated with it. 

   

 

Click a topic to open it in the right-hand pane. 

 

 

 

 

You can click on “How Do I….?” to open a list of hot links to frequently-used topics organized 

by departments.  Click a departmental link to jump to that department’s topics. 
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Index Tab 

The Index tab is similar to the index in the back of a large book.  You can scroll the index to find 

your topic, or simply type a word in the empty field to jump to that index entry.  Highlight an 

item and click Display, or double-click the topic to open it.  

  

Some entries may ask you to narrow your request further.  For example, selecting the entry 

“Enrollment” prompts a request to select from the following list: 
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Click on a topic to highlight it and click Display, or simply double-click the topic. 

 

Search Tab 

The Search tab is blank when it first opens.   

 

Type a keyword or phrase in the field and click List Topics.  Help will retrieve a list of topics 

which contain that keyword or phrase.   
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Open a topic to see that your keyword or phrase is highlighted wherever it appears:   

 

Enclose your search phrase in quotation marks to return a list of only those topics which contain 

the complete phrase just as you typed it. 

NOTE:  Your list of topics may cross departmental lines. For example, if you want information on 

setting up a class schedule, you may type the word “schedule” as a keyword.  It generates a 

list of topics which includes “Approve Disbursements to Pay” because financial aid 

disbursements are “scheduled.” 

 

Favorites Tab 

Use the Favorites tab to bookmark your personal list of favorite (or frequently visited) help 

topics. Click the Add button to add the currently-displayed topic to the Favorites list. You can 

use the Display button to jump to any selected topic from the list. The Remove button only 

removes items from your Favorites list - it does not delete the topic from the help system.  

 

Help System Toolbar 

At the top of the CampusVue Help System window is a toolbar with several convenient features 

or tools. At times some of these tools may be dimmed to indicate that conditions are not right for 

their use. 
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Hide.  Click this button to hide the left-hand frame of the help window. When you click this 

option the Hide button changes to Show. Click the Show button to bring back the left-hand frame 

with the Contents, Index, Search, and Favorites tabs. 

Back.  Click this button to go back to the topic you previously viewed. 

Forward.  Click this button to go forward to a topic you previously viewed. 

Stop.  Click this button to stop loading a help topic or searching for text. 

Refresh.  Click this button to refresh the current help topic. 

Home.  Click this button to go to the first topic in the help system. 

Print.  Click this button to print the current topic or all topics under the currently selected book. 

Note:   Although Help offers the ability to print topics for hard-copy reference, these 

printed materials may someday become obsolete.  As CampusVue is 

continually updated, Help topics may need to be revised.  Online Help will 

always contain the most current information on CampusVue functionality and 

operation. 

Options. Click this button to display a drop-down menu from which you can hide or show the 

left-hand frame (tabs), go backward or forward in the list of topics you have viewed, go to the 

home topic, stop viewing the help system, refresh the help window, print one or more topics, and 

turn off highlighting of search-selected text in topics. 

Shortcut Menus (Right Mouse Button) 

Right-click anywhere inside the left-hand pane of the Help System and a shortcut menu will 

appear. Options on this menu include: 

Open All:  Opens all books and shows all topics in the table of contents. 

Close All:  Closes all books and hides all topics in the table of contents. 

Print:  Prints the current topic. 

View Entry:  Displays entry information about the highlighted topic. 

Jump to URL:  Opens a dialog in which you can enter a Uniform Resource Locator (URL). 

Right-click anywhere inside the right-hand pane of the Help System and another shortcut menu 

will appear. Options on this menu include 

Back:  Takes you back one topic. 

Forward:  Takes you forward one topic. 

Select All:  Selects all text and graphics in the current topic. 
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View Source:  Displays the HTML source code for the current topic page. 

Print:  Prints the current topic. 

Refresh:  Refreshes the current topic on your screen. 

Properties:  Displays the properties of the current HTML page. 

 

Related Topics Button 

At the bottom of most help topics is a Related Topics button. If you didn’t find the information 

you wanted, click the Related Topics button to display other topics with closely-related content.  

 

 

Context-Sensitive Help 

To get instant Help when you have an open form in your work area, press the F1 key on your 

keyboard to open the Help topic pertaining to your open form.
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Appendix A - Keyboard Shortcuts 

The following is a list of frequently-used key combinations.  Some of them are specific to 

CampusVue and some are commonly used in all Microsoft® Windows™ applications. 

Ctrl + L Opens the Quick Lead form 

Ctrl + N Starts a new Student Master record 

Ctrl + E Selects the ‘Edit’ on a data form 

Ctrl + S Saves data on the active form 

Ctrl + Q Cancels the changes made to the active form 

Ctrl + F4 Closes the active form 

Ctrl + P Opens the Print dialog box 

Ctrl +. (period) Makes a Print Screen of the CampusVue window 

Ctrl + F Opens the Student Search engine 

Ctrl + Z Restores previous data (undo) 

F5 Refreshes active form 

F3 Goes to next student 

F1 Opens the CampusVue Help Library 

Shift + F10 Display pop-up menu 

Esc Cancel 

Spacebar Select (same as mouse button 1 click) 

Alt Activate or inactivate menu bar mode 

Alt + Esc Display next window 

Alt + Spacebar Display control panel  

Alt + Enter Display property sheet for current selection 

Alt + F4 Close active window 

Alt + F6 Switch to next window within application 

Alt + Print Screen Capture active window image to the clipboard 

Print Screen Capture desktop image to the clipboard 

Ctrl + Esc Access the Start button on taskbar 
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